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Description 

Managing the metadata associated with your designs can be a confusing task. If you are using 
Vault, the first step in the process is realizing that Vault Properties and Inventor’s iProperties are 
different. Also, you have to understand the difference between a Vault System Property and a 
Vault User-Defined Property. Once you understand all the different types of properties involved, 
how do you get them to work together? In this class, Steve Olson will guide you through the 
journey from understanding the difference between iProperties vs. Vault Properties and Vault 
System Properties vs. Vault User Defined Properties. Then he will demonstrate how to create 
the proper mappings that will allow them to work seamlessly together. Steve will discuss 
different ways to use this data, from searching Vault for these properties to how to use those 
properties on drawing Title Blocks and Parts Lists. 
 

Speaker 

Steve Olson is the Manager of Training Services at MESA Inc., an Autodesk Partner serving 
Western Pennsylvania, Ohio, and beyond. He has been working with Autodesk software since 
2005.  He has experience with Inventor, Fusion 360, Vault, AutoCAD, AutoCAD Civil 3D, 
InfraWorks, ReCap, and more. Steve gained industry experience during his 5 years as a 
draftsman and Vault Administrator for Fleetwood Folding Trailers, an RV manufacturer. At 
MESA, Steve teaches classes, develops and implements training programs, supports Autodesk 
products, and consults with customers regarding their use of Autodesk products. He is an 
Autodesk Certified Instructor and holds Professional Certification in several Autodesk products.  
Steve has spoken at AU and MESA sponsored Events several times and he contributes content 
to the It's A CAD World blog and YouTube Channel. 
 

 

Learning Objectives 

• Differentiate between Vault Properties and Inventor iProperties 

• Describe the process of how to create and map Vault properties 

• Leverage the new Vault Properties while searching 

• Utilize the connection between Inventor and Vault to ease the process of managing 
file metadata 
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One very important part of CAD Management is understanding and managing the metadata that 
is associated with your company’s engineering data.  If you are unfamiliar with the term 
metadata, a simple definition is all the properties on your files.  When using Inventor and Vault, 
you are dealing with two different sets of metadata, the properties in the Inventor files and the 
properties in the Vault database.  Out of the box, Vault is set to map a lot of its properties to 
Inventor's iProperties, or vice versa.  It does such a great job that most users don't realize they 
are dealing with two different sets of metadata. 
 
The primary benefit of connecting your Inventor iProperties to the Vault database is that it will 
allow users to take advantage of Vault’s searching capabilities.  This will enable users to find 
and reuse data more easily.  Also, through bi-directional mapping, users will have greater 
flexibility in where they can edit property values. 
 

Understanding the Two Types of Properties Involved 

Let’s start by understanding the two sets of metadata that we are working with when using 
Inventor and the Vault.  To recognize the difference, it is important to understand how Vault is 
structured.  Vault's information is split into two parts: the file store and the database.  The file 
store is all of the files that are stored in the Vault.  The database is a SQL database that stores 
all of the metadata of the files.  So when a user is in Vault looking at all the files in a particular 
folder, they can display a variety of properties.  In this case, they are looking at the properties in 
the database for those files.  Again, most of Inventor's iProperties are already mapped to Vault 
Properties, so it gives the illusion that you are looking at Inventor’s iProperties. 
 

 
 

 

When working with Vault property definitions, it is important to know that Vault has two types of 
properties, User Defined Properties (UDP) and System Properties.  System Properties are 
attributes that Vault needs to keep track of, and you are not allowed to edit these properties or 
map to these properties.  Some examples of System Properties are:  Checked Out By, Date 
Version Created, and Revision, just to name a few. 

 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/1241018132034942218
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Vault System Properties 

 

 

 
A User-Defined Property can be anything a user needs to track.  Vault has a significant number 
of UDPs out of the box, but Vault Administrators can add as many properties as needed.  The 
default User Defined Properties are editable and some are already mapped to Inventor 
iProperties. 
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Vault User Defined Properties 

 

 
Now, Inventor's iProperties have essentially the same role.  They are designed to allow users to 
track attributes of the design and populate Bills of Material or Title Blocks.  Just like Vault, they 
can be edited and users can create additional custom iProperties.    
 

Inventor’s iProperties 

 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/1241018132034942218
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Creating Vault Properties 

Having an understanding of the differences between Inventor iProperites and Vault Properties, 
let’s take a look at the process of mapping iProperties to Vault Properties to make use of 
Inventor and Vault easier.   
 
The first step is to open the Property Definitions dialog, which is located on the Behaviors tab of 
the Vault Settings dialog, which can be found by going to Tools> Administration> Vault Settings. 
 

 
 

 
 

https://www.blogger.com/blog/post/edit/3920802096530026590/8583881864057041682
https://www.blogger.com/blog/post/edit/3920802096530026590/8583881864057041682
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Vault Property Definition Dialog 

 

 
Once you are at the Property Definitions Dialog, it is just a matter of clicking on New and 
entering the desired information. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/8583881864057041682
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For the most part, some of these options are straight forward.  For example, Name is the name 
of the property.  As long as you are not using special characters or duplicating an existing 
property name, there shouldn't be any issues here.  Type is just what type of data is going into 
this field.  Is it text, a number, a date, or a true/false value? 
 
The Associations are a little more in-depth.  When it comes to Vault Basic, Vault Workgroup, or 
Vault Professional, there are different functions inside of Vault, and the new property can be 
associated with any one of those objects.  The Associations control if the new property is going 
to be a property for files.  If so, which categories?  Is the property going to be associated with 
Items?  If so, what kinds?  And so on. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/8583881864057041682
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After Associations, the user will need to define some of the specific settings for that 
property.  One option is to have this property included when someone does a Basic 
Search.  There are also additional options to set an initial value, force a list of values, require a 
value, etc.  Each association can have these set independently from another. 
 
Then there is the Mapping tab.  This is where the mappings are defined between the Vault 
Property and the File Properties.  The one prerequisite for this step would be to have a CAD file 
that already has the desired property defined.  Since most of Inventor’s iProperties are already 
mapped, this will most likely be a Custom iProperty. 
 
To illustrate the process I will use a property called Stock Location.  It is the location in the 
warehouse that this part is stored.  My Inventor file will have a custom iProperty named Stock 
Location and it will hold that value. 
 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/8583881864057041682
https://www.blogger.com/blog/post/edit/3920802096530026590/4784252482226133532
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As long as you have one Inventor file with that iProperty definition, you are ready to map it to 
your Vault Property.  If not, create that property on a CAD file and return to the Property 
Definition dialog.  Where you would select the property you want to map, click Edit, and switch 
to the Mapping tab.  

 

 
 
Then on the Mapping tab of the edit dialog, you will be able to click on "Click here to add a new 
mapping."  This will enable a row for you to define the mapping, each of these fields are drop-
down menus.  I always start with the Provider column.  Clicking in that cell will show a drop-
down of all the different types of providers available.  In our case, we will pick Inventor (.ipt, 
*.iam, *.idw, *.ipn, *.ide).  Please note the other possible selections as well. 

 

 
 

Then you will need to designate the File Property.  For this, Vault will want a sample file that it 
will pull property definitions from.  It is capable of pulling from the Vault or a local file, so make 
sure to pick the proper option based on where the sample file is stored.  Then click "Import 
Properties" and pick the proper option. 

 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/4784252482226133532
https://www.blogger.com/blog/post/edit/3920802096530026590/4784252482226133532
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Then the user will be prompted to select the sample file and the File Property drop-down will be 
populated with all the properties defined in that file. 

 

 
 

The user can select the desired property from the list.  I do want to point out that Vault will retain 
that same list during this session of Vault, so if you want to map several properties to properties 
from the same sample file, you will only need to pick that sample file once.  Also, if you pick a 
second sample file, this list will display both sets of properties.  If this list gets too cumbersome 
because of adding several sample files, the icon next to "Import Properties" will clear the list. 
 
There are two other options here that are good to understand.  The Mapping can be defined as 
bi-directional or one direction.  For a user-defined property, you will have several options.  If you 
are mapping a Vault System Property to an iProperty, you will only be able to have Vault push 
its value to Inventor.  This is because Vault System Properties are not editable by users.  
Setting Create to "Yes,” will tell Vault to add the property to any file that doesn't already have 
that property.  Once all of the options have been selected and the user clicks out of that row, the 
mapping is defined and moved below the dividing line in the dialog. 
 
It is possible to create multiple mappings on the same properties if multiple mappings exist.  In 
these cases, the mappings can be ordered or prioritized from greatest to least.   

 

 
 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/4784252482226133532
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I will caution against creating too many mappings, I have talked to several customers recently 
that have cyclical, or conflicting, mappings and it results in undesired property behavior.  So be 
careful when creating multiple mappings for the same property. 
 
Also, just creating the mappings will not automatically cause the property to be populated with 
the data from the CAD file.  Running a re-index on the Vault will prompt Vault to begin pulling 
the data from the mapped properties into the Vault database.  If you don't perform a re-index, 
the mapping will be carried out as files are checked into the Vault or when a Synchronize 
Properties is performed on the file. 
 

Performing Searches on the New Property 

The ability to search on the new properties is one of the primary benefits of connecting your 
Inventor iProperties to the Vault database.  The process of searching for these properties can 
be as simple as using the Basic Search field at the top of the main pane of the Vault.  The 
caveat to this is that the property definition needs to specify that the property is included in a 
Basic Search. 
 

 
 

 
 

Regardless of whether that property is set as being included in the Basic Search or not, you can 
still include it in the Search with Query Builder or Advanced Search. 
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Using Vault Mapped Properties in Inventor 

Placing properties on a title block isn't that difficult, but if you haven't done it before, you may not 
know where to start.  Also, custom iProperties are a little bit tricky.  To explain how to do this, I 
am going to say that I want to add Stock Location and Originator to my title block.  The 
Originator is mapped to receive the username of the person that originally checked the file into 
the Vault.  Also, I want to add Stock Location to my Parts List.  That way someone in the 
warehouse can look at the drawing and know where to find the parts. 
 
Since this is something that we want on all of our drawings, I am going to edit my drawing 
template.  I will need to have a model that already has those iProperties.  Then I will need to 
open my drawing template.  To do this properly, you want to use File> Open to open your 
template.  You don't want to go to File> New.  Once the template is opened, you need to add a 
base view of a model that contains those custom iProperties.  It doesn't matter what the model 
is because we will delete the view once we have placed its Custom iProperties in the title block. 
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The next step is to edit the title block.  You can right-click on the title block on the active sheet, 
in the browser, or on a title block listed under the Drawing Resources.  Then click Edit 
Definition. 

 

 
 

This opens the sketch of the title block.  It can be a little overwhelming because you are going to 
see dimensions, names of properties that populate the title block, and labels for those 
fields.  Most often these will run together and make it a little hard to read.  However, zooming in 
on certain sections will help. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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In this example, I am using the default Inventor Title Block.  I have decided to change QA to 
Originator, then place the Originator property in that block.  Then I will add Stock Location at the 
bottom of that column.  So first I will double-click on QA to change the text of that label to 
Originator.  Then, I can use the Text command to add a place holder for this property into the 
title block sketch.  To get the custom iProperty into the place holder, you will need to use the 
drop-down boxes above the text window to pick the right iProperty type\source, then the desired 

property.  Then clicking the "x" symbol will place that property into the text window. 

 

 
 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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After the text is placed, you can control the position of the text, in relation to the insertion point, 
through the two sets of justification toggles. 

 

 
 

Then at the sketch level, the insertion point can be constrained or dimensioned to locate it 
properly. 

 

 
 

So now, I am going to insert a text label, using the text command to label the last box Stock 
Location.  Then, I will insert the Stock Location custom iProperty into that box.  The following 
image is what it should look like when done. 

 

 
 

When you are done editing your title block sketch, you can click Finish Sketch to exit sketch 
mode.  Inventor will ask if you want to save the edits or if you want to do a Save As.  In my 
example, I will just save it. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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Adding Stock Location to the Part List is pretty simple, but there is a wrinkle that makes it more 
difficult.  The issue is that Parts Lists are style-based, which means they pull definitions from the 
Style Library.  So I could modify the Parts List Style in the template, but if I don't add it to the 
Style Library, I could have the change undone by the Style Library.   
 
Before changing the Parts List style, you will need to make sure that your Inventor Project has 
Use Style Library set to Read-Write. 

 

 
 

I typically tell users that this setting should be set to Read-Only because I don't want users 
inadvertently making changes to the company’s styles.  To change this from Read-Only to 
Read-Write, you will have to make sure all of your Inventor files are closed and if you are using 
Vault, the project will have to be checked out to you. 
 
After you have made that change, you can open the drawing template and navigate to the Style 
Editor.   

 

 
 

Under Parts Lists, you will see all the Part List definitions in this template and the Style 
Library.  You are most likely using one customized to your company.  I am using the default 
template in this case.  So I will just copy one of the default styles because I don't like modifying 
the default styles.  I am going to select Parts List (ANSI) and click New at the top.  This will copy 
Parts List (ANSI) and ask me to name the new style.   

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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To add the custom iProperty, I will have to click on the Column Chooser, then select New 
Property.  Then I can click where it says <<Click here to add a new property>>.  Then I can type 
Stock Location, which is the name of the custom iProperty I want to add.  This will be case 
sensitive, so make sure to type it so it matches the way it was spelled in the other places it was 
used.  

 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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Then back in the Column Chooser dialog, the columns can be ordered using Move Up or Move 
Down, which are under the selected properties. 

 

 

 
 

Now the style will need to be saved, by clicking on Save at the top of the Style Editor. 
 
That added the column to the Parts List, but there is one other issue to consider.  Is this Parts 
List going to be our main/default Parts List?  If so, you will want to set this style as the default 
Parts List under the Object Defaults. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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Doing this will make sure that Parts List w\Stock Location will be the default style for Parts Lists 
in the future. 
 
Now we need to save these changes to our Style Library.  That is done by using the Save 
command from the Styles and Standards panel of the ribbon. 

 

 
 

This will compare styles in the drawing to styles in the Style Library and offer to change the 
Style Library's styles to match the ones in the drawing.  Just toggle each style to save to the 
style library or not.  There is also a Yes To All button at the bottom.  Changes to the Style 
Library cannot be undone, so make sure you are ready to do this before clicking OK. 

 

https://www.blogger.com/blog/post/edit/3920802096530026590/875345448996296731
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Once the styles are saved to the Style Library, don't forget to save the template and change 
your Inventor Project back to Use Style Library =  Read-Only.  If you are using Vault, you will 
also want to undo your check out of the IPJ file. 
 

Conclusion 

Using this guide should enable you to create and map your custom Inventor iProperties to Vault 
Properties.  Doing this will enable you to find data more quickly, by giving you more searchable 
fields.  Finding the right design in larger Vaults can be a challenge.  It will also give users the 
flexibility to edit the properties in either Inventor or the Vault. 
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